# Table of Contents

1.0  Introduction .......................................................................................................................... 1  
   1.1  Background ......................................................................................................................... 1  
   1.2  iCare Graphical User Interface ............................................................................................ 1  
   1.3  Who Should Use iCare? ........................................................................................................ 2  
   1.4  User Desktop (Client) Requirements ................................................................................... 2  

2.0  Meaningful Use (MU) Support in iCare ................................................................................. 4  
   2.1  User Preferences and Site Parameters .................................................................................. 4  
   2.1.1  MU in User Preferences .................................................................................................. 5  
   2.1.2  MU Site Parameters ....................................................................................................... 6  
   2.2  Meaningful Use Layout ....................................................................................................... 7  
   2.2.1  Providers Performance Sub-tab ...................................................................................... 8  
   2.2.2  Hospitals/CAHs Performance Sub-tab ........................................................................... 9  
   2.2.3  Providers CQ Sub-tab .................................................................................................... 10  
   2.2.4  Providers CQ Reports Sub-tab ..................................................................................... 11  
   2.2.5  Hospitals/CAHs CQ Sub-tab ........................................................................................ 12  

3.0  Panel Definitions ...................................................................................................................... 14  

4.0  MU CQ Measures NQF Information ....................................................................................... 15  

5.0  MU Menus ............................................................................................................................... 16  
   5.1  File Menu ........................................................................................................................ 16  
   5.2  Edit Menu ...................................................................................................................... 16  
   5.3  Tools Menu ...................................................................................................................... 16  

6.0  Data Processing ..................................................................................................................... 17  

Glossary ........................................................................................................................................ 18  

Acronym List ................................................................................................................................ 20  

Contact Information ..................................................................................................................... 21
Preface

The purpose of this manual is to provide you with the information you need to use the latest enhancements of the iCare (BQI) population management application that support the IHS Meaningful Use (MU) initiative.

This manual contains reference information about iCare views, examples of its processes, and step-by-step procedures to show you how to perform activities related to MU functionality in the latest version of the iCare application.

For more information about iCare basic functionality, iCare usage, or training for iCare, you may consult these resources:

- iCare – IHS OIT
  Available at http://www.ihs.gov/cio/ca/icare/

  Available at http://www.ihs.gov/RPMS/PackageDocs/bqi/bqi_022u.pdf

- HHS WebEx recorded training sessions (search for iCare). Available at
  https://ihs-hhs.webex.com/mw0306lb/mywebex/default.do?siteurl=ihs-hhs&service=7
  or at
  http://www.ihs.gov/cio/ca/icare/index.cfm?module=dsp_icare_cmet_training

- Join the iCare listserv by sending an e-mail to icare@listserv.ihs.gov
1.0 Introduction

iCare is a Windows-based, client-server graphical user interface (GUI) to the IHS Resource and Patient Management System (RPMS). iCare retrieves key patient information from various components of the RPMS database and brings it together under a single, user-friendly interface. iCare is intended to help providers manage the care of their patients. The ability to create multiple panels of patients with common characteristics (e.g., age, diagnosis, community) allows users to personalize the way they view patient data.

The information included in this MU-specific manual covers iCare MU-support functionality enhancements in iCare Version 2.3 (released April 2012). For more information about iCare basic functionality, iCare usage, or training for iCare, you can consult the resources listed above in the Preface.

1.1 Background

Along with the rest of the healthcare industry, IHS has already developed a set of chronic condition management (or register) applications, including for diabetes, asthma, and HIV. This type of application provides a way for healthcare providers to manage a specific group (register) of patients for a single disease state. Register management applications assist healthcare providers to identify high-risk patients, proactively track care reminders and health status of individuals or populations, provide more standardized and appropriate care by embedding evidence-based guidelines, and report outcomes.

Many patients, however, have more than one diagnosed disease. For instance, at the current time within the Indian Health system, a diabetic asthmatic woman could be a member of four RPMS registers (diabetes, asthma, women’s health, and immunizations). This ‘silo’ approach to patient care could potentially result in fragmented care, and could increase the risk of inadequate patient care management due to misidentification of the true level of risk.

1.2 iCare Graphical User Interface

The iCare GUI is intended to allow providers to see a more complete view of patients with multiple conditions, while maintaining the integrity of the user-defined, disease-specific registers.

iCare can help IHS providers by:

- Proactively identifying and managing different groups (populations) of patients who share user-defined characteristics.
• Providing an integrated view of a patient’s conditions that would minimize “stove piped” care management.
• Providing an intuitive and integrated interface to the diverse patient data elements of the RPMS database.
• Facilitating providers a review of clinical quality of care measures for their own patients to enable improvement in the quality of healthcare delivery.
• Enabling views of traditional healthcare information from the perspectives of community, population and public health.
• Providing the default tag selection as Proposed and Accepted, as shown in the above example. You can change the tag selection for any record by selecting or de-selecting any checkbox.
• Clicking the “use AND?” check box when there are multiple tags selected. The “And” option searches for patients who have ALL of the user-defined tags.

1.3 Who Should Use iCare?

Any provider who needs to identify a group of patients for long-term management or to create a temporary list should think about using iCare. Do you fit any of the following scenarios?

• I am a nurse at a facility that assigns a primary care provider to each patient. Every day, I want to create a list of scheduled patients for two different doctors in my clinic.

• I want to identify which of my patients are considered obese so I can recommend nutrition counseling.

• Because providers at our clinic have performance goals related to annual GPRA clinical measures, I want to identify which of my patients are missing key clinical data.

• Our Women’s Health Clinic wants to focus on two clinical performance improvement initiatives this year. We want to identify the performance problem areas for female patients between the ages of 18 and 50.

• I am one of two part-time case managers for a group of children, and I want to create a patient list that we both can use.

• I am a site manager working to ensure our site meets Meaningful Use objectives.

1.4 User Desktop (Client) Requirements

iCare software resides on both your facility’s RPMS server and on the desktop computer that you use. In order to use iCare successfully, your computer should have the following minimum configuration:
### Table 1-1: Computer configuration for installing iCare

<table>
<thead>
<tr>
<th>Client PC</th>
<th>Minimum Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft .NET Framework</td>
<td>V2.0</td>
</tr>
<tr>
<td>Suggested Client PC Hardware</td>
<td>Processor: Minimum: Pentium III 800MHz; Suggested: Pentium 4 2GHz+ Memory (RAM): Minimum: 256MB; Suggested: 512MB+</td>
</tr>
<tr>
<td>Approximate Disk Space Requirements</td>
<td>iCare Application Footprint ~10MB .NET 2.0 Framework ~ 100MB (if not already installed via Windows Updates)</td>
</tr>
</tbody>
</table>
2.0 Meaningful Use (MU) Support in iCare

Meaningful Use (MU) is a new initiative to improve the health of the nation. To achieve meaningful use, healthcare providers and hospitals must meet criteria created by the Office of the National Coordinator (ONC) and the Centers for Medicare and Medicaid Services (CMS).

You can find more information about Meaningful Use at the following Web site: http://www.ihs.gov/recovery/index.cfm?module=dsp_arra_meaningful_use.

![Figure 2-1: Meaningful Use main view (highlighted in red)](image)

The Meaningful Use window provides information about the Meaningful Use objectives and measures for providers as well as hospitals/CAHs. The Meaningful Use team has developed logic related to Meaningful Use objectives and clinical quality measures. This logic is utilized to perform periodic iCare background jobs to obtain related data for display.

2.1 User Preferences and Site Parameters

The User Preferences and Site Parameters windows have been updated to accommodate Meaningful Use support.
2.1.1 MU in User Preferences

To define the filters for the Providers CQ tab, select **Tools | User Preferences | Meaningful Use** tab then select the Providers CQ tab. Select the appropriate filters and other control settings that will apply when viewing the Providers CQ tab.

![Figure 2-2: MU Providers CQ User Preferences dialog](image)

The **By Measure Set** and **By Measure** apply to the Providers CQ and Providers CQ Reports sub-tabs. Use either one (cannot use both).

**By Measure Set**

Select the **By Measure Set** radio button to use all of the selections for each Measure Set checked. For example, check **Core** to use all the available selections for the Core measure set.

**By Measure**

Select the **By Measure** option to use only certain selections under any of the measure sets.

Click **Edit** to access the Add/Remove MU Measures window. You must expand any one of the Measure Sets to see the available selections.
Show Previous Column

Check this checkbox to have the application display the Previous column under each measure (on the Providers CQ sub-tab).

- By checking this item, both Current and Previous columns will display.
- By not checking this item, only the Current column will display.

2.1.2 MU Site Parameters

The MU Package Manager can access the MU Site Parameters screen by selecting Tools | iCare Site Parameters | MU Site Parameters (Figure 2-4). With the ORES security key, this user can customize the list of Providers that is listed on the Providers Performance tab and set the default timeframes for displaying MU performance and CQI measures data. The MU Package Manager can also select whether or not to show the user type and which user types will be displayed on the Providers Performance tab.
2.2 Meaningful Use Layout

In Figure 2-5, the date displayed above the grid is from the most recent background job.

The columns can be sorted and/or filtered. You cannot move the columns from one objective to another, however. But you can move the columns within one objective. For example, you could move the Current and Previous columns under the CPDE Medication objective. The layout information is provided for each sub-tab on the Meaningful Use window.
2.2.1 Providers Performance Sub-tab

Providers Performance is a sub-tab under Meaningful Use. The following explains the contents in this tab as seen in Figure 2-5.

Figure 2-6: Sample Providers Performance sub-tab

- The Provider field is the name of the provider.
- The Type field is the type of provider. The MU Package Manager defines and assigns the user types (see Section 2.1.2 for more information).
- Each of the remaining columns has a Tooltip that defines the meaning of the data in the particular column. To display a Tooltip, hover over the column heading with the mouse.
- Each column is further divided into Current and Previous periods. The Tooltip for Current and Previous columns displays the time frame for that period (for example, Jan 12, 2011 – Apr 12, 2011).
2.2.2 Hospitals/CAHs Performance Sub-tab

The data displayed in the **Hospitals/CAHs Performance** sub-tab reflects the MU objective. The following is an explanation of the contents in this tab as seen in Figure 2-7.

- The number of active patients is displayed above the grid in bold black lettering.
- The **Measure** field displays the name of the measure.
- **Measure Set** is the classified as either **Menu Set** or **Core**.
  - **Core** means that every hospital or provider must be able to meet the measure.
  - **Menu Set** is a list of optional measures that the hospital or provider will choose from.
- **Stage 1 Goal** is the percentage of the Stage 1 goal. The target is >30%.
- The remainder of the window is divided into two sections labeled **Current** and **Previous**. There are Tooltips for both **Current** and **Previous**, which define the date range (for example, Jan 12, 2011 – Apr 12, 2011).
- The **Current** portion of the table applies to the current date range and contains the following columns:
  - **# Patients in Denominator** is the total number of patients in this objective who meet the denominator definition.
  - **# Patients in Numerator** is the total number of patients in this objective who meet the numerator definition.
  - **% Met** is the percentage of the patients who meet the measure, derived by dividing the numerator by the denominator.
• The Previous portion of the table applies to the previous date range and contains:
  - # Patients in Denominator is the total number of patients in this objective who meet the denominator definition.
  - # Patients in Numerator is the total number of patients in this objective who meet the numerator definition.
  - % Met is the percentage of the patients who meet the measure, which is derived by dividing the numerator by the denominator.

For the MU Performance Measures (Provider and Hospital/CAHs), the Time Frame value in the banner above the data table determines the time frame for the data that is displayed. The Time Frame drop-down list (Figure 2-8) has the following options: 90 days, one year (12 months), and one month. The default is 90 days. If you change to the 12-month period, this will be the new default for subsequent logins. The MU Package Manager sets the default time frame.

Figure 2-8: MU Toolbar - performance measures

The Background Jobs button that is located to the right of the Time Frame field (Figure 2-8). Click this button to access the Background Jobs pop-up window. An alternative to clicking the Background Jobs button is to select File | Background Jobs.

2.2.3 Providers CQ Sub-tab

The Providers CQ sub-tab (Figure 2-8) displays how meaningful use and other initiatives have improved the care that the patients received. These measures are reported for each provider.

Providers are required to report on three core measures and three to five additional measures that vary depending on the provider’s specialty of care (for Stage 1). For Stage 1, meaningful use and providers are not required to meet any targets.

The name of the provider is displayed in the Provider column. Each of the remaining columns defines the various criteria for the providers, with each criteria divided into Current and Previous date ranges.
Above the **MU Providers CQ** and **Hospital/CAHs CQ** data tables, the **Time Frame** drop-down box is displayed (Figure 2-9, highlighted in red). A **Starting Month** drop-down box is displayed to the right of the **Time Frame** box. Select the exact starting month from the **Starting Month** drop-down box desired for the 90-day, one month, or one-year time frame.

**Optional filters** in the left sidebar can be used to limit columnar data display in this table, thereby reducing the amount of horizontal scrolling required. Refer to Section 2.6.1 for more information.

### 2.2.4 Providers CQ Reports Sub-tab

The new MU CQ functionalities provide CQ reports (Providers CQ, Providers CQ Reports for any provider(s) and for any 90-day measurement period (Figure 2-10). The main differences of this report versus the standard RPMS report are (a) you can run it for multiple providers instead of a single provider, and (b) you get a grid/table view of the results.

The reports can be run by MU CQ measures or by MU CQ measure sets via the filtering tool on the left sidebar that can be used to limit columnar data display in this table, thereby reducing the amount of horizontal scrolling required (Figure 2-10 highlighted in red).
2.2.5 Hospitals/CAHs CQ Sub-tab

The **Hospitals/CAHs CQ** sub-tab displays how meaningful use and other initiatives have improved the care that the patients received. These measures are reported for each hospital (Figure 2-11).

Hospitals are required to report on a set of 35 Medicare inpatient measures and potentially 8 Medicaid inpatient measures (for MU Stage 1). For Stage 1, MU providers and hospitals are not required to meet any MU targets.
The following is an explanation of the contents in this sub-tab.

- The number of active patients is displayed above the grid in bold black lettering.
- The Measure field displays the name of the measure.
- Measure Set displays the Measure Set name.
- Stage 1 Goal is the percentage of the Stage 1 goal. The target is >30%.
- The remainder of the window is divided into two sections called Current and Previous. There is hover help for both sections that defines the date range (for example, Jan 12, 2011 – Apr 12, 2011).

- The Current portion of the table applies to the current date range and contains the following columns:
  - # Patients in Denominator is the total number of patients in this objective who meet the denominator definition.
  - # Patients in Numerator is the total number of patients in this objective who meet the numerator definition.
  - % Met is the percentage of the patients who meet the measure, derived by dividing the numerator by the denominator.

- The Previous portion of the table applies to the previous date range and contains:
  - # Patients in Denominator is the total number of patients in this objective who meet the denominator definition.
  - # Patients in Numerator is the total number of patients in this objective who meet the numerator definition.
  - % Met is the percentage of the patients who meet the measure, which is derived by dividing the numerator by the denominator.
3.0 Panel Definitions

New functionality in the Panel Definition view features a checkbox for Patient(s) did NOT have to enable users to search for patients who have not had a specified medication(s) in a specified time frame. In addition, Patient(s) did NOT have functionality has been added to the Lab Tests panel definitions (Figure 3-1).

The Patient(s) did NOT have features also appear on the Patients Assigned to population search.

This functionality will be useful to clinical quality improvement efforts (e.g., MU, IPC, GPRA) by allowing users to identify panels of patients who are behind in their preventive and other periodical care. This information will facilitate outreach to these patients via iCare, EHR, and other RPMS components.

![Figure 3-1: Panel definitions choices for Patients(s) did NOT have](image)

**Note:** When using the medication or lab test taxonomies, ensure that these have been populated with local data by the local iCare Package Manager.
4.0 MU CQ Measures NQF Information

For the MU CQ measures data, a Tooltip for the measures names (accessible at the top of each measure column) contains the NQF number of the MU measure. This National Quality Forum ID number identifies the original NQF quality standard that was used as the basis for design of the MU measure (Figure 4-1 highlighted in red).

Figure 4-1: NQF ID number in CQ measures definition Tooltip

The following NQF reference provides information about these numbers:

http://www.qualityforum.org/projects/i-m/meaningful_use/meaningful_use.aspx
5.0 MU Menus

The File menu options (except Meaningful Use) operate the same as the options on the File menu of Panel List.

5.1 File Menu

Meaningful Use options on this sub-menu function like the buttons on the toolbar.

5.2 Edit Menu

The Edit menu has two options:
- Select All will select all of the rows in the grid.
- Deselect All will deselect all of the currently selected rows in the grid.

5.3 Tools Menu

The Tools menu options operate the same as the options on the Tools menu for the Panel List.
6.0 Data Processing

The MU Provider Clinical Quality (CQ) scheduled job in iCare has been removed. MU Provider CQ data will now be automatically calculated on a month-by-month basis on the first of the month (for example, December 1, 2011 calculates data for November 2011). Previous month’s data from June 2011 up to the date of installation will be set up to populate as part of the post-installation process.

Notes: These MU calculations will not run during the site’s normal business hours.

The number of providers processed is based on the providers defined in the MU site parameters. The MU Coordinator should review this MU site parameters list for completeness.
Glossary

**Background Job**
Any number of jobs scheduled to run periodically to update the data used in iCare displays.

**Critical Access Hospital**
Rural community hospitals that receive cost-based reimbursement.

**Denominator**
The bottom part of a common fraction that indicates how many parts the whole is broken into. In iCare, the entire population eligible for meeting certain medical criteria.

**iCare Package Manager**
The designated person with authority to manage all information settings for iCare.

**Meaningful Use**
A government standard for the use of electronic health records.

**MU Package Manager**
The designated person with authority to manage MU information settings for iCare.

**Numerator**
The part of a common fraction appearing above the line, representing the number of parts of the whole that are being considered. In iCare, the number of patients meeting certain medical criteria out of an entire population eligible for meeting the criteria.

**ORES**
Made-up name for a security key given to users that are authorized to write orders in the medical chart. Users with this key can use their electronic signature on patient orders. This key is typically given to licensed physicians. Orders entered by users with this key can be released to ancillary services for immediate action.

**Parameters**
A programming variable that allows the user to input data. Parameters are commonly used to filter data for display or reports.
Panel Definition
The membership criteria used to create a panel of patients.

Tooltip
A common GUI element used to provide additional information to users. To display a Tooltip, hover the mouse pointer, without clicking, over a column heading or field.
## Acronym List

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>BQI</td>
<td>Namespace for iCare</td>
</tr>
<tr>
<td>CAH</td>
<td>Critical Access Hospital</td>
</tr>
<tr>
<td>CMS</td>
<td>Centers for Medicare and Medicaid Services</td>
</tr>
<tr>
<td>CQ</td>
<td>Clinical Quality</td>
</tr>
<tr>
<td>CQI</td>
<td>Clinical Quality Improvement</td>
</tr>
<tr>
<td>EHR</td>
<td>Electronic Health Record</td>
</tr>
<tr>
<td>GPRA</td>
<td>Government Performance and Results Act</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>HHS</td>
<td>Health and Human Services</td>
</tr>
<tr>
<td>IHS</td>
<td>Indian Health Service</td>
</tr>
<tr>
<td>IPC</td>
<td>Improving Patient Care</td>
</tr>
<tr>
<td>MB</td>
<td>Megabytes</td>
</tr>
<tr>
<td>MU</td>
<td>Meaningful Use</td>
</tr>
<tr>
<td>NQF</td>
<td>National Quality Forum</td>
</tr>
<tr>
<td>OIT</td>
<td>Office of Information Technology</td>
</tr>
<tr>
<td>ONC</td>
<td>Office of the National Coordinator</td>
</tr>
<tr>
<td>OS</td>
<td>Operating System</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>RPMS</td>
<td>Resource and Patient Management System</td>
</tr>
</tbody>
</table>
Contact Information

If you have any questions or comments regarding this distribution, please contact the OIT Help Desk (IHS).

Phone:  (505) 248-4371 or (888) 830-7280 (toll free)
Fax:  (505) 248-4363
Web:  http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm
Email:  support@ihs.gov